
 

EVAL-ADT7516EBZ Evaluation Board User Guide 
UG-911 

One Technology Way • P.O. Box 9106 • Norwood, MA 02062-9106, U.S.A. • Tel: 781.329.4700 • Fax: 781.461.3113 • www.analog.com 

 
Evaluating the ADT7516 SPI-/I2C-Compatible, Temperature Sensor, 4-Channel ADC 

and Quad Voltage Output DAC 
 

 
PLEASE SEE THE LAST PAGE FOR AN IMPORTANT  
WARNING AND LEGAL TERMS AND CONDITIONS. Rev. B | Page 1 of 14 

FEATURES 
Easy evaluation of the ADT7516 
Evaluation software included 
USB interface to PC 
Powered from USB interface 

APPLICATIONS 
Portable battery powered instruments 
PCs 
Smart battery chargers 
Telecommunications systems 
Electronic test equipment 
Domestic appliances 
Process controls 

EQUIPMENT NEEDED 
USB A to Mini-B cable 
ADT7516 evaluation board 

DOCUMENTS NEEDED 
ADT7516 evaluation board data sheet 

SOFTWARE NEEDED 
ADT7516 evaluation software on CD 

 

GENERAL DESCRIPTION 
The EVAL-ADT7516EBZ evaluation board allows the ADT7516 
digital temperature sensor, 4-channel analog-to-digital converter 
(ADC) and quad digital-to-analog converter (DAC) to be 
quickly and easily evaluated using a PC. Using the evaluation 
board and its accompanying software, the ADT7516 evaluation 
board can interface with any PC via a USB port. The software 
works on 32-bit Windows® 7 machines and earlier versions like 
Windows XP. 

The evaluation board allows all the input and output functions 
of the ADT7516 to be exercised without the need for external 
components. The software allows control and monitoring of the 
internal registers of the ADT7516. 
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EVALUATION BOARD HARDWARE 
The ADT7516 combines a 10-bit temperature to digital converter 
and a quad 12-bit DAC, respectively, in a 16-lead QSOP. These 
devices include a band gap temperature sensor and a 10-bit ADC 
to monitor and digitize the temperature reading to a resolution of 
0.25°C. The ADT7516 operates from a single 2.7 V to 5.5 V supply. 
The input voltage range on the ADC channels is 0 V to 2.28 V, and 
the input bandwidth is dc. The reference for the ADC channels 
is derived internally. The output voltage of the DAC ranges from 
0 V to VDD, with an output voltage settling time of typically 7 ms. 

The ADT7516 provides two serial interface options, a 4-wire 
serial interface that is compatible with SPI, QSPI™, MICROWIRE™, 
and DSP interface standards and a 2-wire SMBus/I2C interface. 
The ADT7516 features a standby mode that is controlled via the 
serial interface. 

The EVAL-ADT7516EBZ evaluation board contains the following 
main components that can be identified from the printed circuit 
board (PCB) silkscreens and the schematic diagrams (see Figure 15 
to Figure 21): 

• ADT7516 IC (U1) 
• USB microcontroller (U9) 
• Interface buffers and analog switches 
• Power LED, green (D1) 
• Interrupt LED, red (D2) 
• Temperature sensor (Q1) 
• Photodiode sensor (U14) 
• Bar graph driver and LED bar graph (U12/U8) 
• Connector for USB interface (J1) 
• DAC output connector (J2) 
• VREF input connector (P1) 
• AIN analog input connector (P2) 
• LDAC push-button (S1) 

 

 

 

USING THE HARDWARE 
The hardware is extremely simple to use. Before connecting the 
evaluation board to a USB port on the PC, using the USB A to 
Mini-B cable provided, make sure the software is installed. No 
external power supply is required. 

MINI-B USB CONNECTOR (J1) 
The connections to J1 are shown in Table 1. 

Table 1. J1 Connections 
J1 Pin  Mini-B Function  
1  5 V  
2  −Data  
3  +Data  
4  Key (not used, connected to ground)  
5  Ground  

The communication between the Mini-B plug and the rest of 
the evaluation board is handled by the USB microcontroller (U9). 

DAC OUTPUT CONNECTOR (J2) 
The output of any one of the four DACs (selected by the 
software) is available on this connector. 

VREF INPUT CONNECTOR (P1) 
The architecture of one DAC channel consists of a resistor 
string DAC followed by an output buffer amplifier. The refer-
ence voltage for the selected DAC is determined by the on-chip 
reference of 2.28 V or an external reference voltage, which may 
be connected to P1. 

AIN ANALOG INPUT CONNECTOR (P2) 
The ADT7516 offer four single-ended analog input channels, 
which range from 0 V to 2.28 V, or 0 V to VDD. This analog 
input may be connected using P1. 

TEST POINTS 
Various system logic signals and the individual DAC outputs 
are available at the test points on the board. 
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EVALUATION BOARD SOFTWARE QUICK START PROCEDURES 
The software allows control of the ADT7516 functions from a 
PC via an easy-to-use interface. The contents of the internal 
registers of the device can be read easily or altered through a 
user friendly interface, while the Visual Display dialog box gives 
a graphical display of the temperature and the voltage and allows 
the overtemperature limit to be altered using a slider control. 

INSTALLING THE SOFTWARE 
To install the software, insert the supplied CD. Click Start > 
Run, and enter X:ADT7516Eval.exe, where X: is the letter of 
your CD drive, and then click OK. 

Alternatively, run Windows Explorer or go to My Computer, 
select the CD drive, and double-click the ADT7516 v2.0.2.exe 
icon. 

The installer extracts the files needed to install the software and 
starts the InstallShield® Wizard. 
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Figure 1. InstallShield Wizard Startup Screen 

Click Next > to continue the installation. Various installation 
options are available, depending on whether a version of the 
software is already installed. A license agreement appears if this 
is a completely new installation. Click Yes to accept the agreement 
and continue with the installation. 

If you want to install the software in the default folder shown, click 
Next >. Otherwise, click Browse and choose a different folder. 
Select the folder in which to install the program and click OK. 

You are given the option of a Typical, Compact, or Custom 
installation of the software. Select the desired option and click 
Next >.  

If Custom is selected, a window appears allowing individual 
components to be installed. Uncheck any components you do not 
wish to install, and click Next >.  

 

 

 

If a Typical or Compact installation is selected, omit this step, 
and the Select Program Folder dialog box will appear. This box 
allows you to select the program folder to add the program 
icons to. Select the desired folder and click Next >. 

InstallShield now installs the program files to the selected folders. 

Click Finish to complete the installation. 

If an existing version of the software is found during installation, 
you may modify the existing installation by adding or removing 
components, repair the installation by replacing existing files 
with ones from the CD (useful if a file has been corrupted), or 
uninstall the entire software package. 

Select the desired option and click Next >. If Modify is selected, 
you may add or remove components. If Repair is selected, all of 
the installed files are replaced with the new files from the CD.  

If Remove is selected, a prompt appears to confirm the complete 
removal of the software. Click OK to confirm removal of the 
software. During removal of the software, you may need to 
confirm removal of some files. 

These files may be used by other Analog Devices, Inc. software. 
If no other Analog Devices software is installed on the system, it 
is safe to delete the files. To remove all shared files without 
further prompting, check Don't display this message again 
before clicking Yes. 

Click Finish to complete the maintenance procedure. 

USING THE SOFTWARE 
When using the software, first ensure that the evaluation board 
is connected to the USB port and the Power LED D1 is on.  

To start the software, click Start > All Programs > Analog 
Devices > ADT7516 Evaluation Software > ADT7516 
Evaluation Software. 

The software searches for the evaluation board and initializes it. 
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Figure 2. EVAL-ADT7516EBZ Evaluation Software Found 

 

 

http://www.analog.com/ADT7516?doc=EVAL-ADT7516EBZ_UG-911.pdf
http://www.analog.com/ADT7516?doc=EVAL-ADT7516EBZ_UG-911.pdf


EVAL-ADT7516EBZ Evaluation Board User Guide UG-911 
 

Rev. B | Page 5 of 14 

If the evaluation board is not found, the message in Figure 3 
appears. If this happens, check that the evaluation board is 
connected correctly, that D1 is lit, and then try again. 
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Figure 3. EVAL-ADT7516EBZ Evaluation Software Not Found 

At the top of the program window is a series of drop-down 
menus and menu icons that can access the various functions of 
the software (see Figure 4), or you can use the Settings menu to 
select these functions. 
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INTERRUPTS AND LIMITS ICON
DAC OUTPUT CONTROL ICON
REGISTER TREE ICON
GRAPH DISPLAY ICON
CONFIGURATION ICON
DATA LOG ICON

 
Figure 4. Menu and Icon Bar 

The menu icons include the following:  

• The Interrupts and Limits icon sets up interrupts and limits. 
• The DAC Output Control icon allows adjustment of the DAC 

outputs. The Settings menu can also select these functions. 
• The Register Tree icon displays a tree of the device registers. 
• The Graph Display icon displays the temperature and 

voltage graphs. The View menu can also select these 
functions. 

• The Configuration icon allows device configuration.  
• The Data Log icon allows data to be logged and saved. The 

File menu can also be used. 

Multiple windows for the previous software functions can be 
open and active simultaneously. The Window menu shows 
which window is on top and allows any window to come to the 
front. 

Configuration 

Click the Configuration icon or use the Device menu to access 
the Configuration dialog box to set up the ADT7516. It consists 
of a set of four tabs that allows configuration of various functions of 
the device. 

 

 

The Devices Options tab (see Figure 5) selects or enables/disables 
various options, such as monitoring, power down, averaging, 
interrupt, active low INT polarity, and SPI interface. 
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Figure 5. Device Options Tab 

Note that if the ADT7516 SPI interface is enabled, it is necessary to 
exit the software, disconnect the board, and start again to switch 
back to the I2C interface. 

Pin AIN1 to Pin AIN3 are multiplexed and their operation can 
also be toggled here.  

The DAC Options tab (see Figure 6) selects the output range 
for each DAC (0V to VRef or 0V to 2VRef). It allows 
configuration of the thermal voltage function of the device, 
where the ADT7516 operates as a temperature to voltage 
converter, with DAC A controlled by the on-chip temperature 
sensor, and DAC B controlled by the external temperature 
sensor. To set the temperature corresponding to the 0 V output, 
adjust the analog offset for each channel. In addition, the 
resolution for the thermal voltage function can be set to 8 bits 
or 10 bits. 
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Figure 6. DAC Options Tab 
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The LDAC Options tab (see Figure 7) allows users to select 
how the DACs are updated. The DACs can be updated 
manually from the LDAC pin by pressing S1, when the MSBs 
are written to one of the DACs (three different options are 
available), or from the LDAC register. If the LDAC register is 
selected, the LDAC Generation buttons are active, and clicking 
one of the buttons updates the corresponding DAC. 
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Figure 7. LDAC Options Tab 

The Reference tab (see Figure 8) allows users to select the internal 
2.28 V reference for DAC A and DAC B and DAC C and DAC D, 
or an external reference connected to P1. When using an external 
reference voltage, specify its value in the box provided to allow 
the DAC value to scale correctly. 

04
82

7-
01

4

 
Figure 8. Reference Options Tab 

Register Access 
Click the Register Tree icon or use the View menu to select the 
Register Map Access window. 

The Register Map Access window (see Figure 9) allows viewing 
of the individual register’s content, and this register that is 
read/write can have its content changed. The window on the left 
shows the registers arranged by function as a tree. The branches 
can expand or contract by double clicking the desired labels or 
the + or − symbols. 
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Figure 9. Register Map Access Window 

The register name, its address, and its content in hexadecimal, 
decimal, and binary format are displayed. Click Read to read the 
register contents, or check off Continuous Read to set to 
continuous reading. To change content in the read/write 
registers, click on the individual bits of the binary display to 
toggle them, or enter a decimal or hexadecimal value in the 
Read/Write area and click Write. 

Graphing 

Click the Graph Display icon or use the View menu to access 
the Graphing window (see Figure 10). 
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Figure 10. Graphing Window 

The Graphing window allows the internal or external temperature, 
VDD, the DAC outputs, or Pin AIN1 to Pin AIN4 to display as a 
rolling graph. Measurement limits can also be displayed. To view 
the graphic data in more or less detail, move the arrow pointers on 
the x-axis and y-axis to zoom in or zoom out. 
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DAC Control 

Click the DAC Output Control icon or use the Device menu to 
access the DAC Control window (see Figure 11). 

The DAC Control window allows manually controlling the 
individual DACs without having to manipulate the DAC 
registers directly. To select and control a DAC, select a DAC 
(DAC A, DAC B, DAC C, or DAC D) and use the slider. 
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Figure 11. DAC Control Window 

Setting Interrupts and Limits 

Click the Interrupts and Limits icon or use the Device menu 
to access the Interrupt Settings dialog box (see Figure 12). 

The nine interrupt sources are shown on the left side of the 
window. When an interrupt asserts, the corresponding green 
status indicator turns red. To mask interrupts, check the box 
next to the name of the interrupt source. Use the slider controls 
to set the high and low limits for the measured parameters. 
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Figure 12. Interrupt Settings Window 

Data Logging 

Click the Data Log icon or use the File menu to access the 
Logging/Save/Recall dialog box. 

The Logging/Save/Recall window (see Figure 13) allows users 
to set the log inputs and the log intervals. Once this is set up, 
the window in Figure 14 appears. 
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Figure 13. Logging/Save/Recall Window 

To open an existing log file, use Open window (see Figure 14) or 
type in a new file name to create a new log file. When you select an 
existing file or type a new file name, click Open to begin data 
logging and then click Start Logging. To stop data logging, click 
Stop Logging. Note that the Graphing function must run during 
data logging or the data does not change. 
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Figure 14. Opening or Creating a Log File Window 
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EVALUATION BOARD SCHEMATICS AND ARTWORK 
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Figure 15. EVAL-ADT7516EBZ Evaluation Board Schematic Part 1 
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Figure 16. EVAL-ADT7516EBZ Evaluation Board Schematic Part 2  
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Figure 17. EVAL-ADT7516EBZ Evaluation Board Schematic Part 3  
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Figure 18. EVAL-ADT7516EBZ Evaluation Board Schematic Part 4  
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Figure 19. EVAL-ADT7516EBZ Evaluation Board Silkscreen  
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Figure 20. EVAL-ADT7516EBZ Evaluation Board PCB Layout (Component Side)  
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Figure 21. EVAL-ADT7516EBZ Evaluation Board PCB Layout (Solder Side)  
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ORDERING INFORMATION 
BILL OF MATERIALS 

Table 2.  
Component Part Description  
AIN1 to AIN3 Red test points  
C1, C2 22 pF, 50 V, NPO, SMD ceramic capacitors  
C3  47 μF, 10 V, SMD, tantalum capacitor  
C4  2.2 μF, 10 V, SMD, tantalum capacitor  
C5 to C10, C12 to C16, C18, C19, C21 to C30 0.1 µF, 16 V, X7R, multilayer ceramic capacitors  
C11  10 μF, 10 V, SMD, tantalum capacitor  
C17  1 μF, 10 V, dc, Y5V, ceramic capacitor  
C20  10 μF, 10 V, SMD, tantalum capacitor  
D1  Power light emitting diode (LED), green 
D2  Interrupt LED, red 
J1  USB Mini-B connector (USB-OTG)  
J2  2-pin terminal block (5 mm pitch), CON\POWER 
P1  50 Ω, SMB jack, output connector  
P2  50 Ω, SMB jack, output connector  
Q1  PNP, bipolar transistor, 2N3906 
Q2  Low power bipolar transistor, BC807-40LT1 
R1  0 Ω, 1% SMD resistor  
R2, R4, R5, R11, R12, R15, R17, R21 10 kΩ, 1% SMD resistors  
R3, R6 100 kΩ, 1% SMD resistors  
R7, R20 1 kΩ, 1% SMD resistors  
R13  1.2 kΩ, 1% SMD resistor  
R14  3.9 kΩ, 1% SMD resistor  
S1  SMD push-button switch (sealed 6 mm x 6 mm)  
T1 to T7, T9 to T11 Black test points  
T8, T12 to T15 Red test points 
U1  ADT7516, 4-channel ADC and quad voltage output DAC  
U2  ADP3303-3.3, precision low dropout voltage regulator  
U3  24LC64, 64 kΩ I2C serial EEPROM  
U4  ADG774, low voltage quad SPDT switch  
U5  TMP36, low voltage temperature sensor  
U6, U7 ADG604, CMOS 4-channel multiplexers  
U8  LED_BAR_ARRAY, LED bar graph  
U9  USB microcontroller, CY7C68013-CSP 
U10, U11, U13 ADG821, dual SPST switches  
U12  IC driver dot bar display, 20PLCC LM3914 
U14  Photodiode sensor, L/V, TSL250R, TAOS 
VOUTA to VOUTD Red test points 
Y1  24 MHz plastic SMD crystal, XTAL-CM309S 
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NOTES 
 

 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement.  This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided 
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional 
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term 
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including 
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may 
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to 
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any 
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice 
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO 
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED 
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF 
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE 
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable 
United States federal laws and regulations relating to exports. GOVERNING  LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of 
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby 
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed. 

©2004–2016 Analog Devices, Inc. All rights reserved. Trademarks and  
 registered trademarks are the property of their respective owners. 
  UG04827-0-2/16(B)  
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